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Preface 
Twelve years ago I was asked by my younger brother to be his wedding photographer. 
Other than my fee (free) I had no professional qualifications to capture the memories of 
his special day. But I did have a digital camera. With it I could take up to 118 pictures! Just 
imagine all the money they would save by not having to develop a dozen rolls of 24s or 
32s. In addition to my “professional” services, my gift to the newlyweds would be framed 
8x10s of the best shots. 

They got what they paid for. 
 

 

When I returned home, I loaded all 118 digital pictures onto my computer. I chose the best 
ones, and printed each on my brand new color ink jet printer. To my horror, every picture 
looked like it was made up of a bunch of tiny squares. The printer was just fine. My 
computer was fairly new. My digital camera was the top-of-the-line. The problem lay in my 
non-understanding of resolution. You see, in order to take 118 pictures, and hoping to 
impress everyone at the wedding party, I changed the resolution on my camera to its lowest 
setting. I did not think for a moment this meant the resulting digital images would be made 
up of fewer pixels and, therefore have no ability to increase the size of the final product.  
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Oh how I wish now I would have read a book like this a few days before the wedding. If I 
had, I would have understood: 

• What makes up a digital picture (lots of pixels) 
• The importance of choosing the right resolution (dots per inch or dpi) settings on 

my camera or scanner software 
• Which file format to use to safely preserve my digital images (jpg vs. tif) 
• The importance of making editing changes only to a COPY of the digital image 

Sounds like pretty boring, technical stuff, eh? (My wife is Canadian – have to impress her 
with my knowledge of ‘eh’ every now and then.) When these four concepts are understood, 
genealogists can safely preserve their original documents and old photographs – without 
regrets. 

Over the years my personal and genealogical digital photo collections have grown to nearly 
20,000 items, and now I have the desire to: 

• Locate any media item (digital picture or video) quickly 
• Share them easily 
• Have access to my collections from any Internet-connected computer, tablet, or 

smart phone 
• Ensure that I will never lose one of them 

Through years of trial and error, learning from the experts, and staying on top of the latest 
technologies, I have developed a strategy that helps me accomplish my goals of digitizing, 
editing, preserving, searching, and sharing effectively and efficiently. Here is the strategy in 
its most elementary form: 

1. Use a good digital camera or scanner to digitize family pictures and genealogy 
documents. 

2. Use software that aids in the both the digitization and the organization of the digital 
media. Through this lens, I use Adobe’s Photoshop Elements. 

3. Use software to easily and inexpensively allow me to share my digital media with 
others through email, the cloud, and mobile devices. I use a combination of 
Photoshop Elements, Google’s Picasa, and a number of online services. 

4. Use multiple backup tools to ensure that my digital media will always be safe. 

  



Preface 15 

 

 

This book will: 

• Teach what makes up a digital image 
• Explain the three golden rules of working with digital images: 1) right resolution, 2) 

right file format, and 3) make editing changes to a copy of the original 
• Show what to look for in a good digital camera and scanner 
• Help you use your photo management software 
• Explain the four steps of scanning a document or picture 
• Teach how to import pictures from a digital camera 
• Demonstrate how to repair your digital photos and improve their quality, while 

safely preserving the original 
• Present an easy-to-use organization system for your digital media with the goal of 

finding anything in under a minute 
• Give step-by-step instructions for using the two most popular photo management 

programs: Photoshop Elements and Picasa 
• Describe and illustrate how to best share your pictures via email, CDs and DVDs, 

printing and mailing, Dropbox, and online via cloud technology 
• Introduce a backup strategy to protect you from the day your computer quits 

So if you are ready to take your digital pictures to the next level, go ahead … turn the page 
… and have fun! 
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A Digital Image is… 
When the average genealogist hears the phrase digital image they first think of their digital 
camera. While this is 100% true – a digital camera does produce digital images (and digital 
movies too) – a scanner (flat-bed, wand, or even the popular Flip-Pal mobile scanner) also 
produces digital images. Therefore, an original will, a newspaper clipping, or even an old 
photograph can turn into a digital image. 

Before digitization: 

 

After digitization: 
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Digital images also come from the Internet. In fact, every picture that we look at online is a 
digital image. We sometimes download those images for our private use. 

Whether we download an image or create it ourselves with our digital camera or scanner it 
is imperative to know what makes up a digital image so we know how to manipulate it later 
if needed. Digital images are made up of pixels! When we look at a printed picture we often 
do not notice the pixels, but when that image is digitized and we zoom in on it, we soon 
notice that the image is made up of hundreds or thousands of tiny dots. Zoom way in and 
you will find that each dot, known as a pixel, has one unique color. All of these pixels with 
all of their individual color variations, when put together make up a digital image. 

Take a look at the images below. The one on the left is my favorite ancestor, Asa Clark 
Brown. Looks pretty good for an old photo, doesn’t it? The one on the right is a zoomed-
in image of his nose. Notice all the tiny pixels that make up this image. Each has its own 
color, and when all of these colorful pixels are put together and zoomed-in at 100%, they 
make up a nice image. 
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What will you do with the digital images? 
To get started, you should have an idea of what you will do 
with the digitized images. Will you: 

• Use them in a presentation? 
• Publish in a book? 
• Email to family? 
• Enlarge to hang on the wall? 

The answer to this question can help you determine how 
you should use your digital camera or scanner to digitize the 
document – sort of.  But because you cannot possibly 
foresee all future uses for a digitized image, follow this 2-
part golden rule: 

1. Save the original digitized image at a high resolution (between 300-600 dots per 
inch) 

2. Save the original digitized image as an archival-type file format (TIF) or be careful 
to only make editing changes to a copy of the original 

Remember, you may get just one opportunity to digitize the image. For example, you are at 
your Aunt Clara’s home in England. She will not give permission to take her original 
photographs with you for fear that they would get lost or never be returned to her. But she 
does give you permission to scan them while you are there. This may be your one chance 
to digitize. Someone who does not understand the golden rule may decide to save hard 
drive space by choosing a lower resolution (the resulting digital file will be smaller) and a 
file format like JPG that uses less room. These settings will be fine if all you want to do is 
view the digital image on your screen, but when you want to publish it in a book or enlarge 
it for framing, you will be out of luck. Therefore, understanding which resolution settings 
and which file format to save the digital image as is crucial. 

  



Chapter 2 ⟡ Before You Digitize 23 

 

 

Resolution 
Resolution means different things for a digital output (screen) versus a printed output 
(paper). A document scanned at 300 dots per inch (dpi) will appear very large on the 
computer screen, and the quality will be pretty good when printed. The same document 
scanned at 72 dpi will appear much smaller on the screen, and the quality will be less when 
printed. However, the document scanned at either 72 dpi or 300 dpi will have the same 
dimensions when printed. You'll have to re-read that a couple of times! If you scanned a 
document at low resolution because you wanted to cut down on the file size, and then later 
you wanted to use the same image for a professional publication, you would not be able to 
unless the original was re-scanned at a higher resolution. 

There are two categories of resolution: 

Printing resolution. For images digitized and then printed, resolution, to an extent, determines the 
quality of the image, not its size. 

If you will be printing your digital image to paper, the higher the resolution you choose 
when you create the digital image (via your camera or scanner) the better it will look when 
printed. The more dots in the picture the smoother and crisper the picture will look. There 
are limitations of course, depending on the type of printer you have, but for the most part 
– higher resolution results in a better-looking picture when printed. This is known as the 
printing resolution. 
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Wireless. Imagine snapping a picture and having it automatically transferred to your 
computer at home, your online photo album, and emailed to your mother. Your family or 
friends can join you on your vacation without you having to put up with them. If the digital 
camera has wireless capabilities built in, you are that much closer to making this happen. 

Keep in mind that the camera will not have Internet built-in, just the ability to use Internet 
tools if: 

• the camera has the wireless capability 
• and you are within a wireless network 
• and can connect to the wireless network 

That might seem like a lot to keep straight. Here’s an example – you are on vacation in a 
city which has free wireless access everywhere. Using your camera, you can connect to the 
open Wi-Fi network. Using either the camera’s built-in tools, or an Eye-Fi card (sold 
separately), after snapping a picture, you can have that picture sent to your Facebook, 
Picasa, Flickr, other accounts, or even your computer. 

You can still go wireless with your digital camera (or even the Flip-Pal mobile scanner 
because it too uses an SD card) even if it is not built in. All you need is a different kind of 
SD card (this is the memory card that you insert into your camera that stores the digital 
images) called an Eye-Fi card. Stick the Eye-Fi card into the SD card slot and snap away. 
There is a little setup involved on your computer first, but depending on your settings, 
once you are within a wireless network range and your camera is turned on, the Eye-Fi card 
begins transmitting your digital pictures to your computer at home or to your favorite 
photo sharing site. 

My parents live over 1,300 miles away, and do not get to spend many holidays with us. 
Imagine this – Christmas morning comes and I snap a few dozen pictures. As I snap the 
pictures, they are instantly uploaded to my Picasa web albums account, to which I have 
given my mother access. She receives an automated email notifying her that I have added 
new pictures to my album, and she is able to watch the new pictures arrive. Wonderful 
technology! 
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If you are snapping pictures in an area without access to a wireless network, consider 
purchasing and bringing your mobile broadband card with you. Though not inexpensive, 
these cards, like the MiFi card from Verizon, act as mobile Wi-Fi hotspots. In other words, 
you can bring access to the Internet with you – for a monthly fee of course. This works 
well when you are at the cemetery snapping away. With your MiFi card in your pocket, and 
your Eye-Fi card in your camera, your pictures are automatically uploaded to your 
computer, Facebook, genealogy society’s Dropbox folder, or your favorite photo sharing 
site. 

The same holds true with the Flip-Pal mobile scanner. Simply remove the included SD 
card, insert the Eye-Fi card, and after scanning your image/document, it gets wirelessly 
transmitted to your desired location. Although I have not heard of it being done, imagine 
the possibilities of a genealogy society working together. They have a couple of people 
scanning documents at the courthouse with their 1) Flip-Pal mobile scanner, 2) Eye-Fi 
card, and 3) wireless access. As the documents get scanned, because of how they set up the 
Eye-Fi settings, the digital images wirelessly transfer to the society’s Dropbox where 
everyone now has access. The possibilities seem endless. 
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How to Import from your Scanner or 
Camera 
Now that you have the perfect scanner, it is connected to your computer, and your 
software is set up, it is time to make your first perfect scan. Here is the summary of the 
process. 

4 Steps to digitizing a photograph or document using a Flat-bed scanner 
1. Open your photo editing software (Photoshop Elements, Picasa) and initiate the 

scan. 
2. Set your scanning preferences. 
3. Scan. 
4. Immediately save the original image. 

Step #1 – Open your photo editing software (Photoshop Elements, Picasa) and 
initiate the scan. 

Before powering on your scanner and placing the picture or document on the scanning 
bed, check the bed and the photo for any lint, dirt, or smudges. You can use canned air to 
blow off the dust on the photo or bed, but probably do not use it for old photos that could 
crack. Now, carefully position your photo or document on the glass just as you would with 
a photocopy machine. Next, close the cover and launch your photo editing software. 
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Photoshop Elements Picasa 
In the Editor (not to be confused with its 
Organizer), go to File > Import and click on 
the desired scanner. Piece of cake. Done 
with step 1. 
 

Click on the Import button (upper left) or 
go to File > Import from and click on the 
desired scanner. Piece of cake. Done with 
step 1. 

 

 

 

Step #2 – Set your scanning preferences. 

This is the part where my illustrations below will probably be a little different than what 
your screen looks like – it depends on the driver software that works with your scanner. 
But the principles are the same. At the very least, your preferences screen should give you 
the ability to adjust the image type (color, grayscale, black&white), and resolution (dots per 
inch). If not, look for a customize or advanced button. In the example below, its default is 
“Full Auto Mode” where the decisions are made for you. You can change this to either 
Home Mode or Professional Mode which give you more control of the scanning 
preferences. 
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Stitching 
Sometimes you run into the problem of the document being too large for the scanner. My 
scanner, which has an 8 ½” x 11.7” scanning surface is not quite large enough for the 
thousands of 8 ½” x 14” pension papers I copied at the National Archives. 

Below are two separate images – the top 85% of the document, and the lower 85% of the 
document. It is the overlap of the image that enables the software to properly merge the 
two together. 

 

To digitize and stitch/merge an oversized document, follow these steps: 

1. Scan the top part of the document and save it. 
2. Scan the bottom part of the document and save it with a different name. 
3. In Photoshop Elements, click the Expert tab and then go to Enhance> Photomerge 

> Photomerge Panorama. 
4. Click on the Browse button and select both files. 
5. Click OK. If you get the question, “Would you like to automatically fill in the edges 

of your panorama, click Yes, and see how it looks. 

The result is a beautifully-stitched document – the full 8 ½” x 14” document as one digital 
image. 
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Another use for stitching is when you want to take a picture of a beautiful scene, but the 
scene is wider than the width of the picture your camera can take. With your camera, stand 
in the same place and take several shots, rotating a little each time to take separate pictures 
until you have photographed the entire scene. Make sure that with each picture you take 
that you overlap the previous picture by about one-third. This enables the photo editing 
software to effectively stitch everything together. 

I found a beautiful two-story cemetery in Oslo, Norway. I stood atop and took seven 
pictures. With Photoshop Elements, I followed these steps to create the panorama: 

1. In the Organizer, highlight each picture you wish to combine. Shortcut: click on the 
first picture, then Shift-Click on the last picture. This highlights all pictures in 
between. 

2. Go to Edit > Photomerge > Photomerge Panorama. 
3. Click the Add Open Files button, then click OK. 
4. Crop the final, combined picture so the edges are filled in how you would like. 
5. I like to then “flatten” the image (Layer > Flatten Image) so I can then Enhance the 

image (Enhance > Auto Smart Fix). 
6. Save the new picture. 
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This new picture ended up being 88 inches wide – perfect to hang on my, uh, 88 inch wide 
extra wall. 

 

How to selectively adjust dark areas of a picture 
If only a part of the image is too dark, create an Adjustment Layer to fix it. Follow these 
steps: 

1. In the Layers palette, click on the circle which is half black and half white. Click on 
Levels. 

2. Drag the black Input Levels slider to the right until the dark area is lightened to your 
satisfaction. The rest of the image will be too light. We will fix this in the next step.  

3. Select the Brush tool in the toolbar and choose a large, soft-edged brush (300 px 
should do). 

4. Press the letter D to select the default foreground and background colors, then 
press X to set the Foreground color to black. 

5. Finally, paint over the area of the picture that is too light. You might need to adjust 
the brush’s opacity level (found at the top) to make sure the lighting is applied 
evenly. 
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Once your photos are tagged, you can use the search box in the upper right-hand corner to 
quickly find pictures that you have tagged: 

 

Picasa’s name tags 

If you would prefer not to manually tag every picture, Picasa’s Name Tag feature is one of 
the areas where the program really shines. Just like Photoshop Elements, it will not do a 
perfect job. Nor can it really replace your efforts in identifying each and every photo, but it 
is just really neat!  

Click on the People group in the left panel and off Picasa goes. When you click on the 
“Unnamed “ name tag, it will show you thumbnails of unidentified faces it has collected. 
Below it found 86 groups (each group can have dozens or hundreds of faces that Picasa 
has detected as belonging to the same person – you can click on the Expand Groups 
button to see everyone in the group) and 6,330 faces. 
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When you type in that person’s name, everyone in that group is now tagged with that 
Name Tag. For instance, for the top left picture above I typed in my name, which brought 
the total unnamed faces down to 6,284. There must have been 46 pictures in that particular 
group where my face was identified in the photo. Now, because I identified that group as 
belonging to me, Picasa took another look at other unidentified photos with faces and 
would potentially suggest other pictures with my facial features in it. 

The first time I did this I was stunned. I began by identifying a face of my mother, which I 
labeled as Debbie. It then took another look at the remaining unnamed faces and gave me 
another group of suggestions. In this next group were pictures of my mother when she was 
about twenty years younger. So I agreed with Picasa’s suggestion by selecting her name, and 
thus associating this next group with her. It then found a bunch more pictures of her, this 
time when she was even younger. I do not know how it does it, but it must look for similar 
facial features such as the eyes, nose, glasses, and more to positively connect the same 
person over the years. 

When you are finished identifying all the faces it presents to you, just click on that person’s 
name in the People group, and immediately every picture where they are included appears. 
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Double-clicking on any of the faces will open the full picture: 
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The Cloud 
In my perfect digital images world, I would have access to my digital images from my home 
computer, my laptop, my smart phone, my tablet, and from any Internet-connected device 
in the world. I could view them, edit them, print them, or email them. My mother would 
also have access to view my pictures. My friends would have access to view certain pictures. 
And my genealogy colleagues would have permission to view selected genealogy digital 
files. 

This perfect world is finally here. It is often referred to as the cloud or cloud computing. 
Wikipedia describes this term as “the use of computing resources (hardware and software) 
that are delivered as a service over a network (typically the Internet).” Sounds boring, 
doesn’t it? What it means is that through the Internet, we can have access to our files from 
our computers or mobile devices, and we can grant others permission to access these files. 

Living in the state of Arizona, our children are thousands of miles away from their 
grandparents in Oregon and Idaho. While we do not get to visit as often as we would like, 
we have bridged the gap a little through our digital pictures and the use of the cloud. To do 
this, I have configured my photo management software to upload my family pictures to a 
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private account on the Internet, and have granted my parents, my wife’s parents, and other 
immediate relatives permission to view and print these pictures. The best part is that once 
the pictures are on my computer, it is an automated process to share them in this way – 
almost. I do have to intentionally tell my software which pictures I want to share. When 
new pictures are added my family is automatically notified of the updates. 

4 Steps to Sharing via the Cloud 
 

1. Digitize and organize the pictures on your computer with Photoshop Elements. 
2. Using Picasa, create an album to be synchronized online. 
3. Select which pictures to share. 
4. Select who you will share with. 

Here are the detailed step-by-step instructions with explanations. 

Step 1. Using Photoshop Elements, I digitize and organize the pictures on my computer. 
You know how to do this by this point in the book. 

Step 2. Next, in Picasa create an Album. The albums section is found at the top of the left 
side panel. Since each album can only hold 1,000 digital images, sometimes I create two 
albums for the year. Click on the blue Create a New Album button to create a new album. 
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Picasa Web Albums – anywhere 
Now that your pictures are in the cloud, you can begin accessing them with your mobile 
devices. My android-based smartphone’s screen is shown below. Using the web browser 
software, I navigated to http://picasaweb.google.com and my web albums appear (shown 
on left). 

Tapping one of the albums brings up the display of all the pictures in the album (shown on 
right).  

http://picasaweb.google.com/
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Tapping a picture displays it in this mode. I cannot 
count the number of times that having these 
pictures on my phone calmed my 2-year-old when 
she was sad. We could look at them in bed, at the 
store, anywhere! This same ability is available on my 
tablet as well. 

About the only complaint I have had with this is 
when I am in an area where Internet access is not 
available for my phone. Without the Internet, I am 
unable to browse to http://picasaweb.google.com. 

 

 

 

 

 

 

This is where a third-party app like Perfect Tool 
for Picasa comes in. Found in the Google Play 
store, it, too provides the ability to browse albums 
and look at individual pictures, but it also provides 
the ability to make the album available offline, 
meaning the pictures can be viewed even without 
the Internet – good for airplanes and basements 
where your phones Internet signal may not work. 

http://picasaweb.google.com/
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If you are like me and now carry your smart phone 
with you everywhere (I used to make fun of people 
who could not detach themselves from their phone) 
you always have access to your camera. With my 
current phone I have taken hundreds of pictures, 
but unless you transfer them from your phone to 
the cloud or your hard drive, you run the risk of 
losing them all. Fortunately smart phone software 
makes it simple to share the photos if you know 
where to look. 

Here is a portion of my phone’s gallery. It has 
pictures of the football game, my bowling high score 
(232!), and even a few home décor samples. Tapping 
on a picture brings up a share button, that leads to 
the “Select an action” screen where you have lots of 
sharing choices. Clicking the Picasa icon lets you 
add a caption and choose the album to which you 
wish to upload. Or tap the Facebook, Google+, or 
Dropbox icons to upload to any of these services. 

Our discussion of cloud-based photo services would 
not be complete without at least a mention of some 
of the other online services. In addition to 
Photoshop.com and Picasa Web Albums, these also 
deserve consideration: 

- Flickr 
- Photobucket 
- Shutterfly 
- SmugMug 
- Snapfish 
- Facebook 
- Google+ 
- SlickPic 
- Many more… 
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